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MAPPING CLIMATE RISK AND 
VULNERABILITY IN THE WEST MIDLANDS 

The climate is changing. As mean 
global surface temperatures rise, it 
brings changes to the climate and 
weather patterns. In the West 
Midlands, the likely changes are 
warmer, wetter winters; hotter, drier 
summers; and more extreme 
weather events. 

We need to adapt to a changing 
climate. Some of the weather 
events we are currently 
experiencing is unprecedented. 
Without adaptation, people, 
infrastructure and the natural 
environment are more at risk to the 
impacts of climate change. 

The impacts of climate change 
are felt differently across the West 
Midlands, as climate hazards and 
socio-economic factors affecting 
people’s ability to cope are 
unevenly spread across the region. 
It is therefore important to 
understand the spatial patterns. 
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Modern society faces several challenges. These include more people living in cities
1
, income and wealth inequality

2
, 

increases in the cost of living
3
, as well as the changing climate

4
. Below are examples of five hazards connected to these 

challenges, which are all interlinked. 
 
These challenges do not affect all people and places equally. Those of disadvantaged socio-economic backgrounds 
may have less ability to cope with hazards and are therefore more likely to be more negatively affected by climate change

5
. 

Climate change brings about many different impacts on 
people. On the right are eight examples of these, which 
citizens must be protected from as much as possible. 
To achieve this, local and regional authorities that make 
decisions for its citizens need to know where climate 
risk is greatest so appropriate actions can be taken. 
 
This guidance document describes the methodology 
used to develop a Climate Risk and Vulnerability 
Assessment map for the West Midlands; co-created by 
the WM-Air project group and the West Midlands 
Combined Authority (WMCA). 
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HOW IS THE CRVA MAP BUILT FOR THE WEST MIDLANDS? 

Figure 1. The cyclical process of developing a CRVA map 

A CRVA map requires several layers of data that would 
contribute to climate risk. The data parameters build a 
picture of climate risk as a function of data representative of 
Hazards, e.g. flood zones, temperature; Vulnerability, e.g. 
social, economic and demographic variables; and 
Exposure, e.g. population density. Each data layer is 
standardised in terms of both spatial scale and values. Then, 
they can be easily combined into one single layer that 
represents the total climate risk across the map. Therefore, it 
is important to note that this CRVA map is not an absolute 
assessment of climate risk and vulnerability, but only relative 
within the boundary of the area being assessed, which in 
this case, is the West Midlands regional boundary. This 
means that it is not directly comparable with other areas. 
 
What tools and functions are required for a CRVA map? 
A Geographic Information System (GIS) application is 
required to build a CRVA map. Throughout this guidance 
document, the Quantum GIS (QGIS)

6
 free, open-source 

application was used; the approach is also compatible with 
ArcGIS. Several functions are used, but the main CRVA 
build uses raster (or matrix) algebra. Data layers are divided 
into small grids (cells) of equal dimension (in this case, 
100m x 100m), with each cell comprising a single value. 
 

Data used for this CRVA map of the West Midlands 
This CRVA map comprises several datasets to produce 24 
underlying layers that form the final CRVA map, shown in 
Table 1. Most data are open source or publicly available, so 
it is a replicable process for other regions or local authorities 
to produce a similar CRVA map. Developing a CRVA map is 
a cycle, shown in Figure 1. It works through four stages: (i) 
data collection, (ii) the scoring and layering of the data, (iii) 
the publication of the maps and (iv) adaptation engagement. 
This process is then repeated when new data are available 
and the map can then be updated. 
 
Why is a CRVA map important for the West Midlands? 
The West Midlands conurbation is the second most 
populous metropolitan county in the United Kingdom. While 
it has undergone substantial redevelopment in recent 
decades, challenges remain, such as climate impacts, socio-
economic deprivation, public health issues, and poor 
housing quality

7
. The CRVA map provides a means of 

understanding where challenges may be concentrated. This 
may help the WMCA, with supporting evidence for climate 
change adaptation reporting to the Government under the 
Climate Change Act 2008

8
, and monitoring progress against 

the West Midlands Climate Change Adaptation Plan
9
. 
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Layer Data type Layer score parameters 

Nitrogen dioxide (NO2) concentration10 Hazard Mean annual concentration per grid square; binned into 20 quantiles 

Annual fine particulate (PM2.5) concentration10 Hazard Mean annual concentration per grid square; binned into 20 quantiles 

Fluvial flood risk11-13 Hazard % coverage per grid square by flood risk; binned into 20 quantiles 

Pluvial flood risk14-16 Hazard % coverage per grid square by flood risk; binned into 20 quantiles 

Open green space deficit17 Hazard % coverage per grid square by green space; binned into 20 quantiles 

Other green space deficit18,19 Hazard % coverage per grid square by green space; binned into 20 quantiles 

Tree canopy cover deficit20 Hazard % coverage per grid square by tree canopy; binned into 20 quantiles 

Local climate zones21** Hazard 0 = completely open space, 1 = most densely built-up, high-rise** 

Surface temperature (summer daily max)22 Hazard Temperature per grid square; binned into 20 quantiles 

Households deprived regarding education23 Vulnerability % of households in category per grid square, binned into 20 quantiles 

Households deprived regarding employment23 Vulnerability % of households in category per grid square, binned into 20 quantiles 

Households deprived regarding health & disability23 Vulnerability % of households in category per grid square,  binned into 20 quantiles 

Households deprived regarding housing23 Vulnerability % of households in category per grid square, binned into 20 quantiles 

Households with dependent children under 15 years23 Vulnerability % of households in category per grid square, binned into 20 quantiles 

Households of single occupancy over 65 years23 Vulnerability % of households in category per grid square, binned into 20 quantiles 

Population of ethnic minority23 Vulnerability % of population in category per grid square, binned into 20 quantiles 

Population whose main language is not English23 Vulnerability % of population in category per grid square, binned into 20 quantiles 

Households with no access to a car or van23 Vulnerability % of households in category per grid square, binned into 20 quantiles 

Households who do not own their property outright23 Vulnerability % of households in category per grid square, binned into 20 quantiles 

Average annual household income24 Vulnerability Mean income per grid square, binned into 20 quantiles 

Average net disposable household income24 Vulnerability Mean income per grid square, binned into 20 quantiles 

% of household income that is disposable24 Vulnerability Mean % of income per grid square, binned into 20 quantiles 

% of household income spent on travel to work24 Vulnerability Mean % of income per grid square, binned into 20 quantiles 

Population density22 Exposure Mean population density per grid square, binned into 20 quantiles 

* Lower resolution open data is available from DEFRA25  

** See Greenham et al.26 for the local climate zone breakdown and assigned CRVA scores 

Table 1. Key information on each layer used to build the CRVA map 
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Figure 2. Total CRVA risk map for the West Midlands at OA level. White boundaries and labels denote the 7 constituent Local Authorities. 

PRODUCING THE CRVA MAP 
The step-by step processes in QGIS to produce each 
underlying layer at the standardised 100m resolution in 
raster format are outlined in Table 2. Once the layers for 
each variable are created, those comprising hazard features 
and vulnerability features are each are summed and 
rescaled to a score range of 0-1, resulting in two new layers 
that summarise the combination of hazard and vulnerability 
data respectively. Only one layer reflects exposure 
(population density) so no further steps are undertaken. 
 
As shown in box 2 of Figure 1, the combined hazard, 
combined vulnerability and the exposure layers are 
combined further to produce the final risk map. This is done 
via raster algebra in QGIS, using the raster calculator to 
multiply the three layers together. It produces a final 100m 
raster layer that can then be rescaled again to create a total 

risk score range of 0-1 across the West Midlands region. 
The step-by-step process to create the combined hazard 
and vulnerability layers, and using these with the exposure 
data layer to create the final CRVA map for the West 
Midlands is outlined in Table 3. 
 
Using zonal statistics in QGIS, the 100m raster layer can be 
aggregated to different area scales. It produces risk scores 
based on the average of all 100m raster cell scores within 
each area. Figure 2 shows the average total risk score map 
for the West Midlands region at Output Area (OA) these are 
areas of between 40 and 250 households and a resident 
population typically between 100 and 625 persons

27
. It 

shows that climate risk and vulnerability are unevenly 
distributed across the West Midlands. Many areas most at 
risk are within Birmingham, Sandwell, Coventry, and Walsall. 
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UTILISING THE CRVA MAP: HOW CAN IT HELP? 

Monitor and evaluate adaptation progress 

An important feature of the climate change adaptation process is that plans are monitored and 

evaluated
28

. Adaptation works effectively when handled as an iterative process. In a CRVA 

context, monitoring and evaluation is achievable as data are updated that are fed into the map. 

As adaptation plans are carried out, these may affect the data that are updated. Consequently, 

overall CRVA scores may change, and potentially see climate risk reduce over time. 

Prioritise adaptation actions 

A benefit of the CRVA is that the data layers can be reviewed to better understand what may 

be primarily influencing the overall scores in different areas. This is particularly useful where 

areas have similar scores. By reviewing the drivers beneath the scores, decision-makers have 

greater insight into what might be a more suitable adaptation solution e.g. different tree options 

or design focused on limiting flood risk in one area compared with air quality/health in another. 

Inform and engage with the community on climate change 

Engaging with stakeholders is essential as part of the adaptation process, particularly those 

directly affected by the impacts of climate change
29

. The CRVA map works as a method of 

communication to stakeholders to raise awareness in the community regarding climate change. 

Outcomes could include improving preparedness and response by citizens in the event of an 

extreme weather event, and may even improve relationships with decision-makers. 

Review development proposals 

More emphasis is needed in addressing climate risk and vulnerability as part of new 

development proposals. The CRVA map is a useful tool to review these, particularly for 

decision-makers in planning. If a new development proposal were located where a CRVA score 

is high, the underlying layers can be reviewed to ensure that developers design to standards 

that address specific climate change challenges, so the development helps reduce overall risk. 

Support inclusive growth 

Areas of greater socio-economic deprivation are often disproportionately affected by climate 

change 
30,31

. Although the causes of this are extremely complex, focusing on adaptation in 

these areas (i.e. those with high overall CRVA scores) helps prevent climate change from 

further exacerbating existing inequalities. As the most climate vulnerable communities are more 

disproportionately affected, prioritising them addresses inclusive growth and reducing poverty. 

Influence local and regional policy 

The CRVA map is a clear and simple communication tool. It can help decision-makers both in 

and outside of climate teams mainstream climate risk and adaptation considerations within their 

local and regional place-based policies. The CRVA map can encourage a “call to action” to 

senior representatives on climate-related issues by demonstrating the links across multiple 

factors of political importance to ensure that climate change issues are addressed.   

Allocate resources and funding 

Where budgets are fixed or limited, the CRVA map provides a quick-glance overview of the 

areas most in need of adaptation, in accordance with areas where CRVA scores are overall the 

highest. Linked to prioritising adaptation actions, decision-makers are then able to review the 

area and the factors driving the CRVA scores to ensure the appropriate or proportionate levels 

of funding and resources are allocated, enabling adaptation plans to be delivered. 



 Data layer Converted layer GIS processing 

 

  

• Reproject using average resampling from current scale using 
100m fishnet grid resolution and extent 

• Clip raster to fishnet grid extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  

• Reproject using average resampling from current scale using 
100m fishnet grid resolution and extent 

• Clip raster to fishnet grid extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  
• Merge EA Flood zone layers then dissolve to "layer" field 

• Merge BGS and EA flood risk layers so that there are 4 
features representing EA Zone 2, EA Zone 3, BGS High 
potential and BGS low potential 

• Create "Weight" field and assign a value of 0.25 to EA features 
and 0.5 for BGS features (as EA Zones 2 and 3 features can 
overlap). The maximum value will be 1 

• Use "union" tool to create duplicate shapes where overlaps 
occur 

• Use "aggregate" tool to sum the weightings with grouping 
expression "geom_to_wkt( $geometry )" 

• Rasterise to a 5m grid with layer extents set to 100m fishnet 
grid to align grids and use "maximum" function 

• Use Zonal Statistics to read mean values into the 100m fishnet 
grid then rasterise 

• Clip raster to fishnet grid extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  
• Merge all downloaded shapefiles for region (repeat for each 

risk level: 1 in 30, 100 and 1000) 

• Dissolve (to "layer" and "hazard" fields) 

• Use field calculator to create a numerical hazard field from 1 
(Low) to 4 (High) 

• Create "likelihood" field using "layer" field as guide (1in30, 
1in100 or 1in1000) 

• Use extract by attribute for each likelihood, then rasterize to a 
5m grid, using 100m fishnet grid extents 

• Sum all three layers using raster calculator (maximum value 
will be 12) 

• Use Zonal Statistics to read mean values into the 100m fishnet 
grid then rasterize 

• Clip raster to fishnet grid extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals)  

 

  

• Rasterise using 100m fishnet grid resolution and extent 

• Replace null values with 0 

• Use raster calculator to inverse values (1 - raster) 

• Clip raster to fishnet grid extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 
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Table 2. Conversion processes of each layer underpinning the CRVA process 
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 Data layer Converted layer GIS processing 

 

  • Filter UKCEH data by green space, vectorise and dissolve  

• Clip raster to fishnet grid extent 

• Merge vectorised UKCEH data with OS Mastermap data 

• Rasterise using 100m fishnet grid resolution and extent 

• Replace null values with 0 

• Use raster calculator to inverse values (1 - raster) 

• Clip raster to fishnet grid extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  • Use raster calculator to convert to binary form ((((raster > 0) = 
1) + ((raster = 0) = 0) / 2) 

• Reproject using average resampling from current scale using 
100m fishnet grid resolution and extent 

• Clip raster to fishnet grid extent 

• Use raster calculator to inverse values (1 - raster) 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  

• Reproject using bilinear interpolation resampling from current 
scale using 100m fishnet grid resolution and extent 

• Clip raster to fishnet grid extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  
• Reproject to the GB coordinate reference system 

(EPSG:27700/OSGB 1936) to 100m cell resolution using  
fishnet grid extent 

• Reproject using nearest neighbour resampling using 100m 
fishnet grid resolution and extent 

• Clip raster to fishnet grid extent 

• Reclassify by table (see Table 3 of Greenham et al., 202326) 

 

  
• In the .csv file, calculate the % of each OA that falls into the 

criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  
• In the .csv file, calculate the % of each OA that falls into the 

criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

  

 
• In the .csv file, calculate the % of each OA that falls into the 

criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 
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 Data layer Converted layer GIS processing 

 

  

• In the .csv file, calculate the % of each OA that falls into the 
criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  

• In the .csv file, calculate the % of each OA that falls into the 
criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  

• In the .csv file, calculate the % of each OA that falls into the 
criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  

• In the .csv file, calculate the % of each OA that falls into the 
criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 
 

  

• In the .csv file, calculate the % of each OA that falls into the 
criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 

  

• In the .csv file, calculate the % of each OA that falls into the 
criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 
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Table 2. Conversion processes of each layer underpinning the CRVA process 
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 Data layer Converted layer GIS processing 

 

  

• In the .csv file, calculate the % of each OA that falls into the 
criteria 

• Join .csv file to OA boundary vector file by OA name 

• Join to grid - 100m fishnet grid by majority score according to 
OA area intersecting the fishnet grid 

• Rasterise using 100m fishnet grid resolution and extent 

• Use quantile function to determine 20 quantile bins (5%iles) 

• Reclassify by table according to bin values (0-1, 0.05 intervals) 

 Provided directly in 
tabular format by WMCA 

 
• WMCA produced percentile ranking of all data in a .csv file, 

using a list of fishnet ID codes aligning with postcode majority 
area 

• Quantiles set in attribute table by adding a column to reclassify 
percentiles via field calculator (e.g. "WHEN @percentile < 0.05 
THEN '0.05'", etc.) 

• Join .csv file to postcode boundary vector file by postcode 
name 

• Rasterise using 100m fishnet grid resolution and extent 

 Provided directly in 
tabular format by WMCA 

 
• WMCA produced percentile ranking of all data in a .csv file, 

using a list of fishnet ID codes aligning with postcode majority 
area 

• Quantiles set in attribute table by adding a column to reclassify 
percentiles via field calculator (e.g. "WHEN @percentile < 0.05 
THEN '0.05'", etc.) 

• Join .csv file to postcode boundary vector file by postcode 
name 

• Rasterise using 100m fishnet grid resolution and extent 

 Provided directly in 
tabular format by WMCA 

 
• WMCA produced percentile ranking of all data in a .csv file, 

using a list of fishnet ID codes aligning with postcode majority 
area 

• Quantiles set in attribute table by adding a column to reclassify 
percentiles via field calculator (e.g. "WHEN @percentile < 0.05 
THEN '0.05'", etc.) 

• Join .csv file to postcode boundary vector file by postcode 
name 

• Rasterise using 100m fishnet grid resolution and extent 
 Provided directly in 

tabular format by WMCA 

 
• WMCA produced percentile ranking of all data in a .csv file, 

using a list of fishnet ID codes aligning with postcode majority 
area 

• Quantiles set in attribute table by adding a column to reclassify 
percentiles via field calculator (e.g. "WHEN @percentile < 0.05 
THEN '0.05'", etc.) 

• Join .csv file to postcode boundary vector file by postcode 
name 

• Rasterise using 100m fishnet grid resolution and extent 

 Not possible to show due 
to multiple datasets used 

 
• Sum all population per postcode in Census .csv file 

• Join Census data to postcode boundary vector file by postcode  

• Convert AddressBase.csv residential data into vector points* 

• Sum the number of properties per postcode 

• Average the number of people per property per postcode 

• Intersect AddressBase points with 100m fishnet grid to find the 
properties per 100m grid 

• Multiply the average population with properties per 100m grid 

• Rasterise, quantile bin and reclassify per other census layers 
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Creating a fishnet grid 
Vector > Research Tools > Create Grid 
A fishnet grid is a vector layer, which is a conversion of another 
vector file into gridded squares. It is used for the CRVA map as 
the reference layer to align all raster conversions. 
 
Resampling: Bilinear interpolation 
Raster > Projections > Warp (Reproject) 
Resampling creates a new raster layer based on sampling from 
another raster layer. The reasons for doing this include 
reprojecting or aligning raster cells to a new grid size or 
position. Bilinear interpolation is a resampling method using the 
weighted four nearest cell centres32. 
 
Resampling: Nearest neighbour 
Raster > Projections > Warp (Reproject) 
Using the same process as bilinear interpolation, nearest 
neighbour resampling is determined by the nearest cell centre 
on the input grid. 
 
Joining attributes by location (summary) 
Processing toolbox > Vector general > Join attributes by 
location (summary) 
This process takes vector attributes and assigns them to each 
grid square. It is therefore a step before converting vector data 
into a raster layer. 

Identifying percentile values of continuous layer data 
Processing toolbox > GRASS > Raster > r.quantile 
This produces a table with the percentile boundaries of 
continuous raster data. To establish 5%ile bins, the number of 
quantiles is set to 20.  
Processing Toolbox > Raster Analysis > Reclassify by table 
After identifying the boundary ranges, the percentile break 
ranges can be set using reclassify by table. 
Rescaling raster layer 0-1 
Processing Toolbox >  Raster Analysis > Rescale raster 
This process quickly normalises a raster layer, where the 
highest value is scaled to 1 and the lowest scaled to 0. This is 
used when rasterising a layer creates cell values between 0 and 
255, reflective of colour band values, or after the summing of 
other layers to normalise the value range. 
 
Local climate zone scoring 
Processing Toolbox > Raster Analysis > Reclassify by table 
See Table 3 in Greenham et al. (2023)26. 
 
Converting total CRVA scores to other geographic 
boundaries 
Processing toolbox > Raster Analysis > Zonal statistics 
CRVA score can be averaged in accordance with vector files 
that include smaller boundaries, such as wards or hex grids. 

References 

32. ESRI (2023) FAQ: What is the difference between Nearest Neighbor, Bilinear Interpolation and Cubic Convolution? Available at: https://
support.esri.com/en/technical-article/000005606 (last accessed 20/03/2023) 
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ADDITIONAL INFORMATION ON GIS TECHNIQUES 
 

This CRVA map used tools within the QGIS application (version 3.28.11 Firenze long-term release). 

Table 3. Final conversion processes to produce the combined risk CRVA map 

 Hazards Vulnerabilities Exposure Combined risk 

 

NO2 concentration 
PM2.5 concentration 
Fluvial flood risk 
Pluvial flood risk 
Open green space deficit 
Other green space deficit 
Tree canopy cover deficit 
Local climate zones 
Surface temperature 

Households deprived regarding education 
Households deprived regarding employment 
Households deprived regarding health & disability 
Households deprived regarding housing 
Households with dependent children under 15 years 
Households of single occupancy over 65 years 
Population of ethnic minority 
Population whose main language is not English 
Households with no access to a car or van 
Households who do not own their property outright 
Average annual household income 
Average net disposable household income 
% of household income that is disposable 
% of household income spent on travel to work 

Population density 
Hazard layer 
Vulnerabilities layer 
Exposure layer 

 

• Ensure all layers are 
loaded in and 
processing has been 
completed per Table 2 

• Use Raster calculator to 
sum all nine layers 

• Save layer down, do not 
save an “on-the-fly” 
temporary raster 

• Rescale raster to 0-1 
range 

• Ensure all layers are loaded in and processing has 
been completed per Table 2 

• Use Raster calculator to sum all 14 layers 

• Save layer down, do not save an “on-the-fly” 
temporary raster 

• Rescale raster to 0-1 range 

• No action 
required, use 
processed 
Population 
density layer 
produced per 
Table 2 

• Use Raster calculator 
to multiply the three 
layers together 

• Save layer down, do 
not save an “on-the-
fly” temporary raster 

• Rescale raster to 0-1 
range (optional) 
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